
HDR (High Dynamic Range Photography)

1. SHOW VIDEO:  SEAN BAGSHAW VIDEO #2:  THE CHALLENGE OF DYNAMIC 
RANGE

2. What is HDR – In Brief?  [THIS RECAPS SEAN BAGSHOW VIDEO – SKIP DURING 
PRESENTATION] 

2.1 High Dynamic Range Photography (“HDR”) is a technique used when the difference 
between the luminance of the brightest and darkest areas of a photographic subject are 
greater than the camera sensor can record (Luminance is a measure of luminous intensity 
per unit area of light traveling in a given direction)

2.2 In photography, the difference between those brightest and darkest areas is called the 
“dynamic range” of the scene

2.3 Differences in luminance in photography are measured in f stops (“stops”) where 
increasing the aperture by one stop doubles the amount of light at the sensor and stopping 
down the aperture by one stop cuts in half the amount of light at the sensor.  
Correspondingly, if the aperture is unchanged, cutting in half or doubling the shutter speed
will cut in half or double the amount of light at the sensor. 

2.4 Exposure Value is a related concept.  In brief, an Exposure Value number represents all 
aperture/shutter speed combinations that give the same exposure to a fixed scene with 
fixed luminance.  F/ 4.0 at 1/60th and f/5.6 at 1/30th both have Exposure Values of 10.  
The step between Exposure Value numbers is equal to one photographic “stop.”  Going 
from an Exposure Value of zero (f/ 1.0 at one second)  to an Exposure Value of 2 (for 
example, f/ 2.0 or a second or f/11 at 30 seconds) is a change of two stops or quadrupling 
the amount of light.  Thus, technically one “stop” refers to opening or stopping down the 
aperture to double or cut in half the exposure, while a change in exposure of one “EV” can
be obtained either with aperture or shutter speed.  But, to keep things simple we will refer 
to doubling or halving the exposure as a change of one stop or one EV, using the terms 
interchangeably.  

2.5 Thus, we can say the maximum number of stops or EVs that the sensor in one of our 
cameras can record is the dynamic range of that sensor

2.6 In HDR, two or more exposures of the same subject are taken with different EVs (called 
“bracketed exposures” or just “brackets”) and subsequently combined to produce a single 
photo.  

3. Ethics and Aesthetics

3.1 Ethics

3.1.1 In nosing around the Internet looking at various aspects of HDR, one question that 
seems to have arisen is whether HDR photography is ethical, that is to say, by going 
beyond what the camera “sees,” aren’t we somehow tinkering with reality and in that 
respect “cheating?”  PUT UP MIDDLE BRACKET FROM 5D BRACKETS - AEB

3.1.2 The infamous Gary Hart, after all, adheres to the “one shot” method:  he takes only 
one exposure and works with that exposure for his final image (he does, of course, 
take many exposures as he works to his final composition and he performs various 
adjustments to his photos in post processing --- those are different things.  He doesn’t
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blend multiple exposures for HDR, focus stacking or anything else)  MAKE 
VIRTUAL COPY OF MIDDLE BRACKET, APPLY LANDSCAPE PRESET AND 
SET WHITE AND BLACK POINTS – WHAT CAN BE ACHIEVED WITH 
SINGLE EXPOSURE OF THAT SCENE

3.1.3 I think the best response is from Ansel Adams in a different but related context:  

3.1.3.1 First, he said that it is impossible for a print to duplicate the range of luminances
of most subjects so that most photographs are to some degree interpretations of 
the original subject tonal values.  

3.1.3.2 He also said that although his work is frequently regarded as realistic, in fact the
value relationships in most of his photographs are far from a literal transcription
of actuality. 

3.1.3.3 He employed numerous photographic controls to create an image that represents
“the equivalent of what [he] saw and felt” (stating that he was paraphrasing a 
statement he heard on a number of occasions from Alfred Steiglitz).  

3.1.3.4 I’m pretty sure if Ansel were around today, HDR would be amongst his tools. 

3.2 Aesthetics

3.2.1 Any photo editing software, but it seems particularly HDR software, can be used to 
create images that are fantastical.  Suffice it to say that HDR techniques can be used 
to create natural looking images that capture the full range of values in a high 
dynamic range scene.  Of course, there is nothing wrong with the fantastical, if that is
what you want to do.   SHOW ATSF OBS FROM MISC PHOTOS --- 
TONEMAPPED SURREAL AND BLACK AND WHITE

4. More on Dynamic Range  SHOW DXO MARK FROM MISC PHOTOS

4.1 The dynamic range of digital camera models has increased dramatically since digital 
cameras where first introduced.

4.2 DXOMark measures dynamic range of various cameras.  While we could quibble about 
their methodology, their results are at least indicative of what may actually be true:

4.2.1 Current full frame models (all according to DXOMark):

4.2.1.1 Canon 5D Mark IV:  13.6 EVs

4.2.1.2 Nikon 850:  14.8 EVs

4.2.1.3 Sony A7R III: 14.7 EVs

4.2.2  Older and APS-C Models (again, per DXOMark):

4.2.2.1 Canon 1D Mark II: 11.1 EVs

4.2.2.2 Canon 5D Mark III:  11.7 EVs

4.2.2.3 Canon 5D Mark II:  11.9 EVs (something is wrong here)

4.2.2.4 Canon 5D (original model, I once had one of these):  11.1 EVs

4.2.2.5 Canon 80D:  13.2 EVs (supposedly, my Canon M5 has the same sensor)

4.2.2.6 Canon 70D:  11.6 EVs (all of the Canons seem to be in the 11 EV range until 
the most recent models (5D Mk IV and 80D)

4.2.2.7 Nikon D810: 14.8 EVs

4.2.2.8 Nikon D800:  14.4 EVs
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4.2.2.9 Nikon D7500: 14.0 EVs

4.2.2.10Sony A7R II: 13.9 EVs

4.2.2.11Sony A6500: 13.7 EVs

4.2.3 DXOMark camera database:   https://www.dxomark.com/cameras/launched-between-
2002-and-2018/launch_price-from-1000-to-43700-
usd#hideAdvancedOptions=false&viewMode=list&yDataType=rankDxo 

4.3 I thought it would be instructive to give a comparison showing the dynamic range of 
common film types we used to used.  

4.3.1 I Googled and pretty much gave up.  Most of the results were from folks who were 
still seemingly stuck on the film vs. digital debate.  

4.3.2 One blogger, Roger Clark, found that using his methodology for testing, 

4.3.2.1 the Canon 1D Mark II recorded 10.6 stops of information, 

4.3.2.2 compared to 7 stops for Kodak Gold 200 (a common color print film) and 

4.3.2.3 5 stops for Fujichrome Velvia (a common professional slide film).  

4.3.2.4 He did note that other testing showed the Canon 1D Mark II with 11.7 stops of 
dynamic range (compare the DXOMark figure, above).

4.4 My NEC monitor (PA242W) has a reported contrast ratio of 1000:1.  That is, the 
luminance of the brightest color (white) that the monitor can display is 1,000 times 
brighter than the luminance of the darkest color (black) that it can display.   Thus, it can 
display a dynamic range of not quite 10 stops.  SHOW STOPS AND CONTRAST 
RATIOS

4.5 Sean Bagshaw, in the video we watched, reported that human eyes could see detail in 10 to
14 stops just gazing at a scene (comparable to current camera sensors), while if we scan 
around a scene, we can see up to 24 stops.

4.6 I also looked on the web to see what contrast ratios might be typical for photographic 
prints.  It seems that on glossy paper stock with very black photo ink may have a 300:1 
contrast ratio (about 8 and one quarter stops) while matte papers, the contrast ratio might 
be 200:1 (about 7 and two thirds stops). SHOW STOPS AND CONTRAST RATIOS – IN 
MISC PHOTOS

4.7 Here is a chart showing Exposure Value Numbers at various f/ stops (with a shutter speed 
of 1 second) and some corresponding powers and contrast ratios that demonstrate the 
range of luminance.  SHOW STOPS & CONTRAST RATIOS – IN MISC PHOTOS

4.8 To sum up:  

4.8.1 Digital cameras (even crummy Canons) are getting pretty good at recording a pretty 
broad dynamic range

4.8.2 That dynamic range is generally much greater than can be displayed on a computer 
monitor or printed on photo paper

4.8.3 It is no where near as wide as what we can see

4.8.4 In the wild, we can still come across scenes that have a broader dynamic range than 
our sensors can record

4.8.5 Hence, the need for HDR
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5. Jumping Into HDR Photography.  We can break HDR photography down into two phases: 

5.1  First, what do we do in the field?

5.2 Second, what do we do in post processing.

6. In the Field:  When and How Do We Bracket Exposures?

6.1 SHOW VIDEO:  SEAN BAGSHAW VIDEO #15:  WHEN AND HOW TO BRACKET 
EXPOSURES

6.2 When:  SHOW MIDDLE BRACKET FROM 5D BRACKETS – AEB

6.2.1 Bracket your exposures when your histogram shows clipping on both ends

6.2.2 First, take an exposure with your meter zeroed (that is, in the middle)

6.2.3 If one end is clipped, adjust exposure until neither end is clipped

6.2.3.1 Use manual mode, OR

6.2.3.2 If in aperture mode,  use exposure compensation

6.2.3.3 If you can adjust so that there is no clipping on either end, you don’t need to 
bracket (but you may wish to in some circumstances)

6.2.4 If your camera allows, set your histogram to RGB mode (this will tell you if an 
individual channel is being clipped)

6.2.5 Some cameras now show a pre-shot histogram in Live View.  If yours doesn’t (or if 
you turn off the histogram display so you can see the live view screen to compose as 
I do often),  then take the shot and evaluate

6.2.6 Turn on the blinkies as a further aid to knowing when you have highlight clipping

6.2.7 Be aware that the post-shot histogram you see when you review an exposure (I 
understand this is called “chimping”) is based on the JPEG file included in your Raw 
photo, not the Raw photo itself.  You probably can recover some of what appear to be
blown highlights or blocked shadows when you process your Raw in post. 

6.2.8 SHOW 5D SINGLES (TWO EXPOSURES, 1 STOP APART, AND RECOVERY OF
ONE) --- THE RECOVERED SHOT SHOWS THAT EVEN THOUGH NOTHING 
(SUPPOSEDLY) IS BLOWN, THE NICE BLUE SKY STILL DOESN’T SHOW. 
CONCLUSION, YOU MAY WANT TO BRACKET SHOTS TO CAPTURE 
BETTER COLOR IN THE HIGHLIGHTS AND CLEANER INFORMATION IN 
THE SHADOWS FOR BLENDING;  SHOW M3 SINGLES (SAME)

6.2.9 When else???

6.2.9.1 You may want to bracket for later blending even though you are clipping 
highlights or blocking darks.

6.2.9.2 Two occasions:

6.2.9.2.1 Bright skies (e.g., at sunset or sunrise, but could also include getting blue 
sky instead of whitish.

6.2.9.2.2 Deep shadows for recovery of detail within increasing noise.

6.3 How:

6.3.1 Shoot in Raw (always and forever, for many reasons)

6.3.2 Use a tripod
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6.3.2.1 Lock all fittings tight

6.3.2.2 Use your bag to weigh the tripod down if it is windy

6.3.2.3 Hand held bracketing is possible, but the results won’t be nearly as good

6.3.3 Use Manual or Aperture Priority

6.3.3.1 Exposure adjustments (the “brackets”) are made by adjusting shutter speed

6.3.3.2 Do not adjust aperture – will impact depth of field and bracketed exposures will 
not properly align

6.3.3.3 Can adjust ISO if need be

6.3.4 Focus

6.3.4.1 Turn off auto focus OR use back button focus

6.3.4.2 Otherwise, the camera may re-focus between shots and your brackets will not be
the same

6.3.5 White Balance.  

6.3.5.1 The issue is ending up with the “correct” (or chosen) white balance for your 
finished image.

6.3.5.2 Depending on your camera, if you use automatic exposure bracketing and 
automatic white balance, your camera may set the same white balance for all of 
the brackets.  That is what the Canon 5D Mk IV apparently does (I have never 
actually checked this out with other cameras but presume they may do the same 
thing).

6.3.5.3 If you manually bracket and use automatic white balance, then you can well end
up with a different white balance setting for each bracket.  SHOW 5D 
BRACKETS – FROM 2 STOPS ETC.   IN DEVELOP MODULE, SHOW 
DIFFERENT WHITE BALANCE “AS SHOT” FOR EACH BRACKET

6.3.5.4 You can handle white balance in various ways:

6.3.5.4.1 First, in the field you can set white balance for the scene (e.g., Sunlight – 
5500).  That way, all of your brackets will have the same white balance 
setting whether you use automatic or manual bracketing. And since you are
shooting raw brackets, you can always change the white balance later

6.3.5.4.2 OR if you use auto white balance, remember to check and set it on all 
bracketed exposures when your do your initial Raw conversion (This may 
or may not work, depending on the software you are using.  Should work 
in Lightroom, not so much in others.  

6.3.5.4.3 OR don’t worry about it and set White Balance either in your HDR photo 
or in your final LDR (that is, regular dynamic range) image 

6.3.6 Manual or Auto Bracketing

6.3.6.1 Auto Bracketing

6.3.6.1.1 Most cameras today can be set to take automatically bracketed exposures

6.3.6.1.2 The following can be set on most modern cameras:

6.3.6.1.2.1 The number of bracket shots (e.g., 3, 5, 7 or whatever)
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6.3.6.1.2.2 The EVs between shots (I have been using 1 EV but some software, 
such as Lightroom, recommends 2 brackets with 2 EVs between)

6.3.6.1.2.3 The sequence (I generally go from lightest to darkest, on the theory 
that when I go to check, if the last shot has blinkies, then I know I 
need to still go darker)

6.3.6.1.3 Auto bracketing is preferred when something is moving in the scene (for 
example, clouds, the light, etc.) or when you don’t have much time

6.3.6.1.4 You can always autobracket and get more brackets than you need for your 
HDR (that is, better safe than sorry)

6.3.6.1.5 SHOW 5D BRACKETS – AEB (7 BRACKETS, TWO STOPS APART)

6.3.6.2 Manual Bracketing

6.3.6.2.1 Seems to be preferred to those in the know

6.3.6.2.2 Gives more control over the number of brackets, the EVs between shots, 
and where and how you measure to determine the number of brackets

6.3.6.2.3 Various techniques

6.3.6.2.3.1 Take a bracket with your meter in middle, evaluate, then adjust 
shutter speed to go lighter (slower shutter speed) until a shot with no 
black clipping, then adjust shutter speed to go darker than middle 
bracket (faster shutter speed) until a shot with no blown highlights is 
obtained (or vice versa) SHOW 5D BRACKETS – MANUAL - 
BRACKETS

6.3.6.2.3.2 Meter brightest part of scene, adjust exposure darker by two EVs 
(faster shutter speed), then take brackets lighter from that point until 
darkest exposure has no clipping in darkest part of scene SHOW 5D 
BRACKETS – FROM 2 STOPS DARKER.  SPOT METER ON 
WINDOW WAS AT 1/250TH (ALL AT F/8, 100 ISO).  POT AT 8 
SECONDS.  SO APPROXIMATELY 11 STOPS.  I STARTED AT 
1/1000THS (TWO STOPS DARKER THAN MEASURED 
WINDOW) AND WENT LIGHTER (LONGER SHUTTER SPEED) 
AT TWO STOP INTERVALS.  COULD HAVE STOPPED AT 1 
SECOND OR TWO SECONDS, BUT TOOK MORE (AT 8 
SECONDS, BECAUSE THAT IS WHAT I MEASURED THE POT 
AT AND 15 SECONDS TO COMPLETE MY 2 STOP STEPS)

7. Post Processing:  How Do We Blend Bracket Exposures Together?

7.1 There are two basic approaches to blending bracketed exposures:

7.1.1 Blend using layers, selections and masks in Photoshop or other post processing 
software that supports layers, OR 

7.1.2 Use software to do the blending

7.2 Neil covered some of the layer/selection/mask approach and I won’t get into, but in 
general:

7.2.1 Load your selected brackets as layers into Photoshop

7.2.2 Use selections and masks to produce a composite
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7.2.3 Selections can be made in various ways, including traditional Photoshop selection 
tools, gradients and luminosity selections and masks can be made by applying 
selections directly or by “painting in” masks using selections, including luminosity 
selections

7.2.4 Note that using this approach, an actual High Dynamic Range photo isn’t created.  
Mulitple low (actually, regular) dynamic range photos are blended together and the 
resulting photo has regular dynamic range

7.3 Today I am going to talk about the other approach to blending:  HDR Software

7.3.1 I will call any HDR Software an “HDR Software package” even though it may be 
included as a feature in a “full featured” post-processing software package as 
opposed to “stand alone” HDR Software 

7.3.2 I am going to tell you about some of the available HDR Software packages

7.3.3 I will discuss a bit about how each of the selected HDR Software packages works, 
and

7.3.4 I will show some comparisons of results I obtained using various HDR Software 
packages

8.   Some of the available HDR Software packages for blending exposures I have used are:

8.1 Lightroom

8.2 Photoshop

8.3 Photomatix Essentials

8.4 Aurora HDR 2018

8.5 On1 Photo Raw 2018

8.6 Nik HDR Efex Pro 2

9. A Bit About Software Created High Dynamic Range Photos

9.1 Unlike the layer/selection/mask approach, all of the various HDR Software packages do 
create an actual High Dynamic Range Photo 

9.2 The problem is that no HDR Photo can be viewed on a monitor (or printed)

9.3 So, the HDR Photo has to be tone mapped (compressed) so that a low (that is, regular) 
dynamic range photo is created for viewing and printing.  Let’s call the regular dynamic 
range photo that is the output of using an HDR Software package the “LDR Result” 

9.4 The various software packages go about this differently, as we shall see

9.5 But, the basic steps in using any of the software packages are:

9.5.1 Select the brackets to be used

9.5.2 Make initial Raw Adjustments to the brackets, if any

9.5.3 Load the brackets into the HDR Software

9.5.4 Use the HDR Software to create the HDR Photo

9.5.5 Adjust the HDR Photo in the HDR Software

9.5.6 Tone Map (compress) the HDR Photo into the LDR Result

9.5.7 Make further adjustments (post processing) to the LDR Result 

9.5.8 Save, view, print, whatever the LDR Result
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9.6 NOTE:  one of the options in Photomatix may be blending as in the layer/selection/mask 
approach, not tone mapping

10. Lightroom

10.1 I will start with Lightroom both because we all use it and because it is the easiest to use to 
select brackets, process the HDR photo and return to Lightroom

10.2 Procedure:  DEMONSTRATE USING ALL BUT TWO BRIGHTEST BRACKETS IN 5D
BRACKETS – AEB

10.2.1 Select (highlight) the bracketed exposures you wish to use (you may decide not to 
use all of the brackets you shot if you decide they won’t help the HDR image)

10.2.2 Take the selected brackets to the Develop Module, adjust one of them (see below for 
what carries over into the HDR photo and what does not), then synch the others

10.2.3 With your selected brackets still selected, go to Photo > Photo Merge > HDR (OR 
select bracketed exposures and Control H)

10.2.4 Brings up a composite view with HDR Options:

10.2.4.1Auto Align – check box if you hand held for the bracketed exposures

10.2.4.2Auto Settings – this applies auto tone and colors to the merged HDR.  It is 
wholly non-destructive, so checking it may provide a useful starting point for 
your further post processing of the merged photograph

10.2.4.3Deghost Amount – use if anything moved between the bracketed exposures.  In 
general, use the least that does the job.  The Show Deghost Overlay will show 
the areas where Lightroom detects movement between brackets

10.2.4.4Click Merge

10.3 What You Get:

10.3.1 Lightroom creates a new, HDR file for the merged photo

10.3.2 The file name will be the same as that of the first bracketed exposure, with the 
addition of “HDR” at the end

10.3.3 This file in in DNG format

10.3.4 The DNG is almost, but not quite, a Raw file

10.3.5 It is a 16 bit floating point image file (which Jeff may understand, but I do not).  This 
should give 30 stops of dynamic range, which should be ample for what we need, 
even with our brackets

10.3.6 Instead of the usual 5 stops of exposure plus and minus in the Develop Module, the 
new DNG will have 10 plus and 10 minus stops

10.4 Next steps:

10.4.1 Edit the new DNG in the Develop Module as you would any Raw file

10.4.2 Some of the pre-merge edits made to the individual bracketed shots will carry over to
the new DNG:

10.4.2.1White Balance 

10.4.2.2Clarity

10.4.2.3Lens Corrections
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10.4.2.4Vignettes

10.4.3 Other pre-merge edits made to the individual bracket shots will be ignored by 
Lightroom in creating the new, DNG composite file:

10.4.3.1Exposure changes (Exposure, Contrast, Highlights, Shadows, Whites, Blacks)

10.4.3.2Local adjustments

10.4.3.3Cropping

10.4.4 Through the magic of Lightroom, you are able to view the HDR DNG photo, even 
though it remains an HDR photo

10.4.5 If your typical post processing involves taking a photo to Photoshop for further work,
you can open it in Photoshop and edit it as a 16 bit file.  Mine comes back to the 
Lightroom catalog as a TIFF (per my Lightroom external edit preferences).

11. Photoshop

11.1 Photoshop is perhaps the most difficult HDR software to use.  On the good side, we all 
have it.  On the not so good side, I found it extremely challenging to find any good 
documentation that discusses all of the various aspects of Photoshop Merge to HDR Pro in
a comprehensive and understandable way.  I will go through what I have discovered so far,
but there may be more out there.  

11.2 Background.  There are basically three ways to use Merge to HDR Pro.  They all start the 
same, opening your selected brackets in the Merge to HDR Dialogue Box.  From there, the
three methods diverge. The three methods are:

11.2.1 Tone mapping (compression) in 16 bit (non-floating) mode

11.2.2  Adjusting the 32 bit (floating decimal) HDR file in Adobe Camera Raw (“ACR”) 
(Note: I am unclear whether this is Tone mapping (compression) or simply adjusting 
tonal information in a file with a much broader range of tonal values.  And, I don’t 
know if that is really a different thing.) 

11.2.3  Adjusting the 32 bit HDR file in Lightroom (Note:  Again, this may be tone mapping
or adjusting, I don’t know)

11.2.4 Note:  you can also select to do your tone mapping in 8 bit mode, but I don’t know 
why you would want to.

11.3 Procedure common to all three modes:

11.3.1 Start in Lightroom

11.3.2 Select (highlight) bracketed exposures, then Photo > Edit In > Merge to HDR Pro in 
Photoshop

11.3.3 Alternatively, you can start in Photoshop and select File > Automate > Merge to HDR
Pro and then use the dialogue box to browse to your brackets and select them.  This 
way, you can select to “Attempt to Automatically Align Source Images” if you didn’t 
use a tripod (it appears that Photoshop will automatically align images when coming 
from Lightroom, probably if this box was once checked)

11.3.4 The photos open as layers in Photoshop and after a good deal of effort, Photoshop 
opens a new “Merge to HDR Pro” dialogue box 

11.3.5 Unlike Lightroom, in Photoshop’s HDR Merge, you can select which brackets you 
want to include in the HDR Photo
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11.3.6   You can have the software attempt to remove ghosts

11.3.7   And here you select which method you are going to use for compressing your 32 bit 
HDR photo to your 16 bit LDR Result

11.4 16 Bit Tone Mapping.  

11.4.1 If you wish to do tone mapping, select “16 Bit” in the Mode box (I haven’t yet 
discovered why you would want to use this Mode, but here is the procedure):

11.4.2 You then have a choice of one of four methods of tone mapping:

11.4.2.1Local Adaptation

11.4.2.2Equalize Histogram

11.4.2.3Exposure and Gamma

11.4.2.4Highlight Compression

11.4.3 Choose Local Adaptation

11.4.3.1I am prepared to believe Scott Kelby when he says that the other methods are 
holdovers from earlier bad HDR of CS4 and earlier and aren’t good choices

11.4.3.2  According to Cambridge In Colour, Local Adaptation “does not necessarily 
retain the overll hierarchy of tones. It translates pixel intensities not just with a 
single tone curve, but instead also based on the surrounding pixel values.  This 
means that unlike using a tonal curve, tones on the histogram are not just 
stretched and compressed, but may instead cross positions.”  Thus, some part of 
the final image that was initially darker than some other part could end up being
as bright or brighter that that other part.  The Local Adaptation method 
“attempts to maintain local contrast, while decreasing global contrast….”

11.4.4 You then adjust a bunch of things:

11.4.4.1Edge Glow has three adjustment tools:

11.4.4.1.1 The Radius slider is the tool for setting the distance between local 
and global contrast (according to Adobe, Radius specifies the size of local 
brightness regions).  Scott Kelby suggests to set at 150 or above

11.4.4.1.2 The Strength slider (per Adobe) specifies how far apart two pixels’ 
tonal values must be before they are no longer part of the same brightness 
region.  Scott Kelby suggest a Strength setting of 0.50 or below

11.4.4.1.3 Adobe doesn’t tell us what the Smooth Edges check box does.  
Scott Kelby said the “Edge Softening” box (which may be the same) says 
“it takes the harshness out of the effect” (not sure what effect he is talking 
about) and that he uses it often.  So, try the Edge Smoothness check box 
and see what you think

11.4.4.1.4 Good luck

11.4.4.2  Tone and Detail also has three adjustment tools:

11.4.4.2.1 Gamma (per Adobe) yields a maximum dynamic range with a 
setting of 1.0.  Per Scott Kelby:  Don’t mess with

11.4.4.2.2 Exposure values (per Adobe) reflect f-stops.  Again per Scott 
Kelby:  Don’t mess with
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11.4.4.2.3 Detail (per Adobe) adjusts sharpness, but I think it is similar to 
Clarity).  Play with it, then reset to its default value (30)

11.4.4.3   Advanced

11.4.4.3.1 Shadows:  Don’t mess with; wait for Lightroom or ACR

11.4.4.3.2 Highlights:  Scott Kelby uses to make grayed areas white again

11.4.4.3.3 Vibrance:  Wait for Lightroom or ACR

11.4.4.3.4 Saturation:  Wait for Lightroom or ACR

11.4.4.4  Curve:  Here is a tone curve, which you can use to add a little contrast.  Or 
wait for Lightroom or ACR

11.4.5 When you are done, click OK and Photoshop creates the HDR image, then applies 
your adjustments and sends you back to the normal Photoshop workspace with a 16 
bit image.  You can adjust that image in Photoshop or save and work in Lightroom. 
But, the resulting image in Lightroom doesn’t have nearly as much capacity as the 32
bit image you can create and work on in Lightroom --- see below

11.4.6   Scott Kelby Alternative:

11.4.6.1  An alternative 16 bit processing starts the same as above, but in the Merge to 
HDR Pro dialogue box, at the top, operate the dropdown next to “Preset” and 
select the “Scott5” preset.  

11.4.6.2  The preset selects Remove Ghosts, which you can uncheck if you don’t have a 
ghost issue.  

11.4.6.3  Then simply click “OK”

11.4.6.4   After Photoshop creates the HDR photo, then uses Scott Kelby’s preset to 
create the LDR Result, you end up back in Photoshop with your 16 bit image, 
looking like a Photomatix pretty nasty tone mapped image.  Not to worry.

11.4.6.5  Go back to Lightroom and find the middle bracket from your set (presuming 
that is the one you most want your end result to be similar to).  Take it to edit in 
Photoshop.

11.4.6.6  You will now have two open files in Photoshop.  Do the following to your 
middle bracket:

11.4.6.6.1 Control A (to select the entire image)

11.4.6.6.2 Control C (to copy it)

11.4.6.6.3 Switch to your LDR Result image, then Control V (to past your 
middle bracket as another layer above your LDR Result

11.4.6.7  Now, if you need to, align layers (if you shot from a tripod, you are likely OK)

11.4.6.8  Now, select the layer with your middle bracket and adjust the opacity so that 
you get the benefit of the LDR Result (tonemapped from HDR) showing 
through on your middle bracket.  Try it, you may like it.

11.5 32 Bit Adjustment in Adobe Camera Raw

11.5.1 In the Merge to HDR Pro dialogue box, Select Mode > 32 bit

11.5.2  With the “Complete Toning in Adobe Camera Raw” box unchecked, you can 
examine the full range of tonalities that will be in your HDR file
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11.5.3 Then, check the box “Complete Toning in Adobe Camera Raw”

11.5.4 If you wish to use fewer than all of your brackets, deselect the unwanted brackets in 
the lower left corner

11.5.5 If applicable, check “Remove Ghosts” and select which bracketed exposure to be the 
one for ghost non-movement (usually EV 0.00)

11.5.6 At the bottom right, select “Tone in ACR”

11.5.7 Photoshop creates a new 32 bit HDR file for the merged image and opens it in ACR

11.5.8 Although the controls are in different places, you have all of the adjustment tools that
you do in Lightroom

11.5.9  Make all of the adjustments that you want to make

11.5.10 Note that you have plus 10 and minus 10 stops of Exposure adjustment, 
instead of the usual plus 5, minus 5 that you normally have in Lightroom or ACR

11.5.11 When you are satisfied, click “OK” in the lower right

11.5.12 You are then returned to the Photoshop workspace with a 16 bit file

11.5.13 You can save that file to work on in Lightroom or continue to edit in 
Photoshop (and any plugins, such as On1)

11.5.14 Depending on the preferences you have set in Lightroom, when you save the 
file, it will be in either the Photoshop (PSD or PSB) format or in the TIFF format. 
This is set in Lightroom in Edit > Preferences > External Editing > Edit in Adobe 
Photoshop CC 2018 > File Format. 

11.6 32 Bit Adjustments in Lightroom --- To use Lightroom instead of ACR to make 
adjustments to the 32 bit Photoshop HDR file:

11.6.1 In the Merge to HDR Pro dialogue box, Select Mode > 32 bit

11.6.2  With the “Complete Toning in Adobe Camera Raw” box unchecked, you can 
examine the full range of tonalities that will be in your HDR file

11.6.3 This is important:  leave unchecked the box “Complete Toning in Adobe Camera 
Raw”

11.6.4 If you wish to use fewer than all of your brackets, deselect the unwanted brackets in 
the lower left corner

11.6.5 If applicable, check “Remove Ghosts” and select which bracketed exposure to be the 
one for ghost non-movement (usually EV 0.00)

11.6.6 At the bottom right, click “OK.”

11.6.7   Photoshop will create the 32 bit HDR image and return you to the Photoshop 
workspace.   

11.6.8 Save the image and close it in Photoshop.

11.6.9   Back in Lightroom, you will have a 32 bit TIFF image that you can adjust in 
Lightroom.  

11.6.10 To verify that it is still 32 bits, select the image and go to Photo > Edit In >  
Edit in Adobe Photoshop CC 2018.  When the file opens in Photoshop, note that it 
remains 32 bits.  Close it and go back to Lightroom

11.6.11  In Lightroom, you can use all the familiar controls to adjust the image.  
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11.6.12 Make all of the adjustments that you want to make

11.6.13 Note that you have plus 10 and minus 10 stops of Exposure adjustment, 
instead of the usual plus 5, minus 5 that you normally have in Lightroom or ACR

11.6.14 If you want to take the photo back to Photoshop for further adjustments, you 
must Edit a Copy With Lightroom Adjustments.  At that point, you lose the 32 bit file
for further editing (but since you are making a copy, the 32 bit file remains if you 
want to try something else with it) 

11.6.15 Note:  You can only edit the 32 bit HDR file in Lightroom if you bring it to 
Lightroom from Photoshop as a Tiff.  You can save a 32 bit PSD file in Lightroom, 
but Lightroom can’t edit it (you won’t be able to view the photo and you will get a 
notice saying “The file uses an unsupported bit depth.”  See above regarding setting 
preferences for TIFF rather than PSD

11.7 Some Discussion of the 32 Bit Photoshop HDR File

11.7.1 Photoshop uses this file to store the luminance values of the HDR file, using a 32 
bit floating point numeric representation (32 bits per channel)

11.7.2 Thus, the new file is not a Raw, but retains all of the HDR information

11.7.3 You can make limited adjustments to the file in Photoshop, but these are actually 
adjustments made to the preview so that your monitor can display the HDR image. 
The preview settings are stored in the PSD, PSB or TIFF file and are applied 
whenever the file is opened in Photoshop (preview adjustments don’t edit the HDR 
image file, in which all of the HDR image information is retained) 

11.7.4 Another way of referring to floating point numbers is exponential notation.  
According to Cambridge in Colour, “A floating point number is composed of a 
decimal number between 1 and 10 multiplied by some poser of 10...as opposed to the
usual integers of 0-255 (for 8-bit) or 0-65535 (for 16-bit).”  So color can be more 
precisely specified.  And, the HDR files use tonal values that are proportional to the 
actual brightness of the subject matter so greater dynamic range can be efficiently 
recorded in the file.  

12. Photomatix:

12.1 There are two versions:

12.1.1 Photomatix Essentials Version 4.2 (I bought Photomatix Essentials back in 2011 
when I first heard about HDR.  I was able to upgrade to the current version (4.2) with
no additional charge.  I have it installed on my Dell Tower and Samsung Laptop 
computers).  The Essentials version has a Plugin for Photoshop Elements.  Cost now 
for a license is $39

12.1.2 There is also a Pro Version, currently Version 6.  I haven’t tried it.  According to the 
HDRSoft website (that is the Photomatix website), the Pro version offers more 
options and includes advanced features such as batch processing and selective 
deghosting.  The Pro version also includes a Plugin for Lightroom.  Cost now for a 
license is $99

12.1.3 The Essentials and Pro versions share the same internal HDR processing engines, but
their interfaces differ.  A comparison sheet is attached

12.2 How to Use Photomatix Essentials:
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12.2.1 Recommends 3 or more exposures, two stops apart (Photomatix Essentials can 
process up to 5 bracketed exposures)

12.2.2 After you open Photomatix Essentials, drag and drop your brackets photos or browse 
to the folder containing your brackets and select them

12.2.3 After brackets are selected, one or more brackets can be excluded from the 
processing by unchecking the box next to its thumbnail

12.2.4 Photomatix has the usual deghosting and alignment features (which can be turned off 
in Preferences)

12.2.5 Next step is to create the HDR image using one of the Presets, then further adjusting 
the Settings that are set by the Preset, if desired (Photomatix Essentials has 33 
“factory” presets; you can also create and save your own)

12.2.6 The Settings that are available to adjust will change, based on the Preset chosen.  
Basically, the chosen Preset selects one of the following tone mapping methods:

12.2.6.1Details Enhancer (Presets:  Detailed; Painterly; Surreal; Grunge)

12.2.6.2Contrast Optimizer (Presets: Balanced; Vibrant)

12.2.6.3Tone Compressor (No preset that I could find)

12.2.6.4Exposure Fusion/Natural Settings (Preset: Natural)

12.2.6.5Tone Balancer (Preset: Realistic)

12.2.7 Photomatix Essentials includes a handy manual, which explains which Presets use 
which tone mapping methods and for each tone mapping method, explains the 
settings available and what which each one does.  There are also explanations shown 
when you mouse over controls.

12.2.8 I’m not sure, but I suspect the Exposure Fusion/Natural Settings is not tone mapping 
per se, but may be closer to an automatic layer/selection/mask approach (I seem to 
recall this from a early version of Photomatix from when I first tried it – the software 
then allowed you to select either a “tone mapping” or a “fusion” approach, as I recall 

12.2.9  What you get:  a 16 bit TIFF file, which you can save back into whatever folder you 
wish.  You will have to import it into Lightroom, however, unless you upgrade to 
Photomatix Pro and get the Lightroom Plugin (which presumably would deposit your
Photomatix result back into Lightroom)

13. Aurora HDR 2018

13.1 What is it:

13.1.1 Aurora HDR 2018 is a standalone HDR package from Skylum Software (which used 
to be called “MacPhun”).  It isn’t cheap:  $99.  Although there may be an upgrade 
price (for example, if you sprang for the 2018 version, could you get next year’s 
version at a reduced price), I can’t be sure.    

13.1.2 Skylum has also made a “complete” photo editing software package called 
“Luminar,” which I have not tried --- I just saw that an upgrade to Luminar 2018 
recently came out

13.1.3 Aurora HDR 2018 seems to be a work in progress.  The good part is that it has many 
presets that can quickly get you to a particular look with your HDR photo.  The bad 
part is that, at least in the Windows implementation, it doesn’t necessarily work as 
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advertised.  In particular, the layers and luminosity mask features appear to be weak 
when compared to using layers and luminosity masks in Photoshop.

13.2 Procedure:  I’m not going to get into, because perhaps none or only a few have Aurora 
HDR 2018 anyway and so it would be a waste of time to go through the steps

13.3 What you get:

13.3.1 You can combine as many bracketed exposures as you would like

13.3.2 The resulting HDR appears to be reasonably well done (although with one photo, I 
had trouble getting the “align” feature to work)

13.3.3 You can select from many presets from Skylum or their associated photographers or 
create your own (including adapting their presets as you like)

13.3.4 Filters give you flexibility to adjust the presets to your liking.  

13.3.5 Results can be saved in various file formats, including 16 bit TIFF, 16 bit PSD or 
JPEG

13.3.6 Batch processing is possible

13.3.7 Uses 32 bit processing for the interim HDR file, which can be saved in Skylum’s 
proprietary HDR file format, which can’t be opened by other software, but could be 
used as your 32 bit HDR file for alternative processing in Aurora without needing to 
go back and create a new HDR file.

13.3.8

14. On1 Photo Raw 2018

14.1 What is it:

14.1.1 On1 Photo Raw 2018 purports to be a complete alternative to Lightroom/Photoshop

14.1.2 It even has a method of migrating your Lightroom catalog to On1

14.1.3 I think several of us have been using the “Effects” module for its very nice Dynamic 
Contrast Filter

14.1.4 It has its own HDR engine

14.2 Procedure:

14.2.1 Start in the On1 Browse Module  (Although On1 Photo Raw 2018 can be used as a 
plugin to Lightroom and Photoshop, I haven’t discovered a way to use the HDR 
engine as a plugin)

14.2.2 Select (highlight) the bracketed exposures you wish to use (you can select an entire 
series of brackets, even if you think you may not use them all, since you can deselect 
any later in the process)

14.2.3 Click HDR button along the right side (or select Create HDR from the File menu)

14.2.4 The Create HDR Window then opens:

14.2.4.1You have the usual options for deghosting and alignment

14.2.4.2You can select one of four Default Looks (the first time you use the HDR 
feature, you chose your Default Look – you can then always change the Look in
the Create HDR Window).  The choices are Natural, Natural Auto, Surreal, and 
Surreal Auto.  The “Autos” apply auto toning, which can be changed later.  The 
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Natural vs. Surreal is the amount of  Compression and Detail applied, which can
be changed later

14.2.4.3You can deselect one or more of your bracketed exposures; once deselected, 
they will not be used in creating the HDR image

14.2.4.4You can select which bracketed exposure will be used as the base image for 
deghosting purposes and as the base in creating the HDR image

14.2.4.5You also pick which On1 Module will open when you save your HDR: Browser,
Develop or Effects

14.2.4.6Along the right side are buttons for two panes:

14.2.4.6.1 The Tone & Color Pane from the Develop Module, which has 
sliders to adjust these attributes

14.2.4.6.2 The HDR Look from the Effects Module, which has:

14.2.4.6.2.1 An Opacity slider (to vary the amount of “HDR Look” 
applied to the composite image),

14.2.4.6.2.2 Presets for Natural, Surreal, Glow, Subtle and  Exaggerated 
Edges n Tone

14.2.4.6.2.3 Sliders which can be used to fine tune the settings made by 
the presets in:

A.14.2.4.6.2.3.1. Compression

A.14.2.4.6.2.3.2. Detail

A.14.2.4.6.2.3.3. Clarity

A.14.2.4.6.2.3.4. Glow

A.14.2.4.6.2.3.5. Grunge

14.2.4.7   When you click Save, Photo Raw builds the HDR photo and saves it in a 
custom format (an On1 Photo Raw proprietary file type, adding “HDR” to the 
file name and with a file type .onphoto    (It appears to be 16 bit, but I don’t 
know whether fixed or floating decimal)

14.2.4.8   This HDR file ( .onphoto) is completely re-editable in any appropriate On1 
Photo Raw Module

14.2.4.9   The HDR file  (.onphoto) can be sent to Lightroom or Photoshop for further 
editing by going to the Browse Module, right clicking the file and selecting 
“Send to Adobe Photoshop CC 2018” or “Send to Adobe Photoshop Lightroom 
Classic 7”

14.2.4.10 If you select to further edit in Lightroom, On1 handily sends a PSD file 
to the Import Window in Lightroom, where you can import it into Lightroom

15. Nik Collection:

15.1 What is happening

15.1.1 DxO purchase the Nik Collection from Google last October

15.1.2 You can still download all seven of the Nik plugins from DXO

15.1.3 DxO is in the process of preparing a new version, which they expect to release in 
2018
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15.1.4 DxO has also been integrating some of the Nik technology into their own photo 
editing software, now called DxO PhotoLab (previously, Dxo OpticsPro)

15.1.5 Specifically, DxO is integrating Nik’s U Point technology into DxO PhotoLab (Gail, 
Paul and I demonstrated U Point technology last year when we talked about the Nik 
collection --- in brief it involves placing a control point and changing various settings
relating to the control point (size, brightness, contrast and saturation).  Multiple 
control points can be placed in an image and can be used to add or subtract an effect.)

15.1.6 As a guess, the new version of Nik will not be free, and may well be fully integrated 
into DxO PhotoLab

15.1.7 As such, I am not reviewing HDR Efex Pro.  It may not be around in its current form 
much longer.  But, it is still around and can still be used, if desired.

16. What am I going to use for HDR going forward??

16.1 I will probably spend a fair amount of time learning the layer/selection/mask approach, 
using both Tony Kuyper’s and Jimmy McIntyre’s luminosity mask panels.
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